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Respondus with WebCT 6.0 
 
Objectives 
 

 Take a survey, self-test, and graded quiz from the student perspective. 
 

 View and retrieve the results of a survey and graded quiz from the instructor 
perspective. 

 
 Go over Respondus Basics – create a simple quiz, change the settings, 

publish it to WebCT. 
 

 Insert images, sounds, and web page links into questions. 
 

 Import questions from a text file into Respondus. 
 

 Create a quiz from existing Respondus “test banks” or quizzes. 
 

 Use Question Sets on a quiz to randomize questions. 
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Taking a Respondus Self-Test as a Student 
 

1. Log into the MCC homepage  (https://webct.mc.maricopa.edu) 
 
2. Input the username and password your instructor provides to log on as a student.  

 
3. Click on the link to mc_ respondus quizzes 

 

4. Self tests are assessments for which the student receives a grade and feedback. 
However, the grade is not recorded and it does not count towards the final grade for the 
course. Self tests are purely for the student’s benefit-  providing an opportunity to test 
knowledge and understanding of course content. 

Click on the Example Self Test icon. 

 
4. Complete the Self Test.   

5.  View the graded test to see what the student sees after the Self-Test is graded. 
Because self-test results are not saved, once you have viewed the results of your self-
test and close the results window, no record of your attempt will remain. 

 
 

 
Taking a Respondus Quiz as a Student 
 

6. Click on the Course Content button (listed under Course Tools, left side of screen) 
to take you back to the course homepage.  

 

 
 
7. Click on the Sample Graded Quiz icon. 

 
 

8. Follow the directions on screen to take and submit the quiz.  
 
9. Click on the View Attempt button to see the graded quiz. Note that the paragraph 

question has not been graded by the instructor yet. 
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Taking a Respondus Survey as a Student 
 
 
10. Click on the Course Content button to take you back to the course homepage. 
 
11. Click on the Anonymous Computer Survey icon. 

 
 

12. Complete the survey and submit it.  
 

 
 
Viewing Results, Adding Bonus Points, Overriding a Grade,  and 
Grading Essay Questions as an Instructor 

 
 

Your instructor will demonstrate how you access the quizzes as an instructor. These are the 
directions you will follow when you are the instructor for the course: 
 

1. Move to the Teach tab. 
 

2. Select Assessments Manager within the Instructor Tools menu. 
 

 
 
3. Use the Tab navigation to view Graded Assessments, Not Graded (contain Essay 

questions that need manual grading), Not Submitted (list of students that have not 
completed the quiz or never finished the quiz).  

 

 
 

Manually Grade a question that is an Essay Question 
• Select the Not Graded tab. 
• Select the ActionLink next to an Assessment, select ‘Grade All Attempts of 

a Single Question’. 
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• Select the ActionLink next to the Question, select ‘Grade all attempts of 
this question’. 

 

 
 

• Select the ‘Hide Names’ tab to grade each question without knowing the 
student’s identity. 

• Select the Attempt link next to each student that has completed the 
question. 

 

 
 

• Read the student’s response; score the question, select ‘Save and View 
Next Attempt’. 

 

          
 

View a Specific Student Submission, Override a Score, add Bonus Points 
• Select Assessments Manager within the Instructor Tools menu. 
• Select the Not Graded tab. 

• Click on View Attempt 1 next to the student's name.    
• Override a score for a specific question by adjusting the Score, then select 

Update Grade. 
• Add bonus points by typing a score into the ‘Adjust total score by:’ box at 

the bottom of the page, then select Update Grade. 

 
 
 

Reset Student Quiz Submission 
• Select Assessments Manager within the Instructor Tools menu. 
• Select the Graded tab. 
• Use the Action Link next to the quiz name and select View Submissions. 
• Use the Action Link next to the student’s name. 
• Delete the student’s attempt and allow them to retake the quiz by selecting 

Reset Entire Submission. 
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View Survey Results in WebCT 
 
View the Completed / Not Completed status for each student 
1.  Move to the Teach tab. 
2.  Select Gradebook within the Instructor Tools menu. 
3.  The Survey column in the gradebook will show as Completed or Not Completed next to 
each student name. 
 

 
 

 
 
View the Results of a Survey 
1. Move to the Teach tab. 
2. Click on the Assessments Tool under the Course Tools menu. 
3. Select the ActionLink next to the Survey, select View Reports. 
 

 
 
 

4. Select the Survey name from the drop-down menu. 
5. Select the radio button next to Performance, select Run Report. 
 

 
 
6.  Download the results or view the results on the screen. 
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Create an Assessment using Respondus 
 
Respondus can create graded or ungraded WebCT Assessments 
 
 A Quiz/Exam is a graded exercise.  The instructor can see who has completed the exam, 

what the results of the exam are, and the results are added to the WebCT gradebook 
automatically. 

 Open Respondus (download instructions on separate hand-out).  
 Use the pull-down menu to Set Personality to WebCT 6/Vista 4. 

 
 

 Create a quiz/test/exam in Respondus by selecting the Start tab, then select Create. 
 

 
 

 Add questions to the quiz by selecting the Edit tab, then select the question type at the 
left, there are 9 question types:  Multiple Choice, True / False, Paragraph, Matching, 
Short Answer, Multiple Response, Fill in the Blank, Jumbled Sentence, and Calculated.  
All questions are automatically graded except for Paragraph questions. 

 For each question, fill in the question information as appropriate.  
1. Type in a question title (this is for the instructor’s organization; the student will not 

see the title). 
2. Type in the question text/wording. 
3. Type in the answer(s). 
4. Select the correct answer(s). 
5. Type in the point value for the question.  
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6. Click on Add to End of List to save the question 
7. Some question formats permit feedback. If you wish to enable feedback, check in the 

box next to that option.      
 
8. Checkmark Randomize if the answers should be randomized for Multiple Choice or 

Multiple Response questions.     
 

 
How to Enter Matching Questions 
 
Matching questions require students to match items from two columns.  
 
There are two ways to create matching questions in Respondus.  

• First, the designer may specify matching pairs for both the left and right 
columns—specifically, the correct match for the left column must be placed in the 
field immediately to the right. If this procedure is followed, it is not necessary to 
indicate the correct answer in the small column located at the far left. (Note it is 
possible to place extra answers in the right column. In this situation, the extra 
answers act as decoys and do not match any of the answers in the left column.) 

 
• The second approach for creating matching questions allows items in the right 

column to be placed in any order, but requires the correct answer for the match 
to be indicated in the small column located at the far left. This approach is 
especially suited for questions in which a long list of items (e.g., country names) 
is being matched to a relatively short list of items (e.g., type of government).  

 
• For example, the left list might contain 25 countries (Afghanistan, Albania, 

Algeria, Angola, Argentina, etc.) while the list on the right might display four 
types of government (Multi-Party Democracy, One-Party Regime, 
Military/Monarchical/Theocratic Regime, Disordered State). Instead of entering 
the type of government for each country, you can simply enter the letter of the 
correct answer in front of the country name. 

 
• In a matching question, the left column will be displayed to the student in the 

order information was entered. The right column appears as a list of drop-down 
menus that students can use to select the appropriate match. Answers in the 
drop-down menus are randomized. 
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• Tip: The easiest way to navigate through the answer choices is to use the PageUp 
and PageDown keys.  Press the PageDown key twice to move through the 
"correct match" field. 

 
• All answer choices are equally weighted with matching questions. So if a question 

has 10 matches, each match is worth 10%.  
 

• There are three choices for grading matching questions:  
 
 

1. Proportional to the Number Correct - All answers are equally 
weighted, without any penalty for incorrect answers. So if a 
student matches 8 of 10 items correctly, the score would be 80% 
on that question.  

 
2. All Points or None – The student must answer all items correctly in 

order to receive 100% credit. If any items are missed, no credit is 
given for the question. 

 
3. Right Less Wrong – This option sums the number of correct 

answers and then subtracts the number of wrong answers. Hence, 
if the student answers 8 items correctly and two items incorrectly, 
the score is 6 (8 correct - 2 incorrect). 

 
 

• A Note About Calculated Questions 
 

Respondus does not allow the creating or editing of calculated questions. However, if 
a calculated question is created in WebCT, Respondus will download these questions 
along with the other question types. Once downloaded, calculated questions can be 
moved, copied, deleted, or resubmitted to the WebCT server. 

 
 
 
9. Save your file. By default, Respondus files are saved in a folder called Respondus 
Projects on the C drive. 

 
 
 
 
How to publish Assessments from Respondus to WebCT 6.0 @ MCC 
 
 Open a Respondus File. 
 Select the PREVIEW AND PUBLISH tab. 
 Select the PUBLISH TO WEBCT option at the left. 
 Select the PUBLISH WIZARD button. 
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• Select MCC from the drop down menu or select –add new server- if this is the first 
time that you’ve used Respondus. 

 
 
 

 
 
 
 
 
• Complete the information for the MCC Server. 

 

1) Select PREVIEW AND PUBLISH tab. 
2) Click PUBLISH TO WEBCT.  
3) Click on the PUBLISH WIZARD 

1) Select the PUBLISH TO SINGLE 
COURSE option. 
2) Select ADD NEW SERVER from the 
drop-down course menu. 
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 Click on Next, give Respondus a couple of minutes to connect to the server. 
 Select the course from the drop down list. 
 Select Create New Category if it is a NEW quiz, select ‘Use an Existing Category’ 

and select the existing category if you are EDITING a quiz. 
 
NOTE:  Respondus does not currently support EDITING a quiz in WebCT 6.0.  You 
will need to delete the existing quiz after adding the new quiz if you are trying to 
EDIT a quiz. 
 

 
 
• Select ‘Create Quiz’ and type in the name to create a NEW quiz.  Select ‘Create 

Self-Test’ and type in the name to create a NEW Self-Test.   
• Checkmark ‘Apply Question Sets’ if you are using Question Sets. 
• Checkmark ‘Apply Settings to the Quiz’ to transfer most of the settings. 
• Click on Next. 
 

Step 1: Do nothing 
Step 2: Type in 
http://webct.mc.maricopa.edu/webct/en
tryPageIns.dowebct 
Step 3:  Click on Extract>> 
Step 4:  Click on Institutions>>, select MESA 
COMMUNITY COLLEGE 
Step 5:   
-Type in a DESCRIPTION for the server (WebCT 
Server or MCC WebCT Server – can be 
anything) 
-Type in your MCC username/password, 
checkmark ‘Remember’ only if you are on your 
own personal computer 
-Click OK 
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• Wait for Respondus to Publish the Assessment.  Do not click on Finished until you 
see a success message.  Click okay if you see an error message. 

 

 
 
 
Modify Assessment Settings in WebCT 
 
After publishing an Assessment to WebCT from Respondus, access the Assessment settings 
as an instructor to decide on duration, availability, security, etc. 
1. Move to the Teach tab. 
2. Click on the Assessments Tool within the Course Tools menu. 
3. Select the ActionLink next to an assessment, select Edit Properties. 
4. Adjust options as desired. 

 
 Change the Assessment title if needed. 
 Add a Description for the Assessment (this is optional). 
 Select Show Item for the Item Visibility. 
 Change the Grade Book column name if needed (it’s recommended that the 

column name matches the Assessment name). 
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 Question delivery:  Decide on the question delivery (the second option is 

recommended, if you display the questions one at a time, it’s more difficult for 
the students to copy and print the quiz).  Uncheck the option for ‘Display 
question titles’ as usually the question titles are not important (are usually just 
used for organizing questions). 

 Display Assessment:  Select ‘In the same browser window’ to have the 
Assessment appear in the same browser window (this prevents popup blocker 
problems). 

 Duration:  Choose a duration (how long the student can spend on an Assessment 
once they open it).  It is recommended that you do not checkmark ‘Disallow 
submission…” in case the student has technical issues.   

 

 
 

 Attempts:  Select the number of Attempts allowed (how many times the student 
can take the assessment).  If you allow multiple attempts, you may want to set a 
minimum attempt time (to force the student to wait before taking the 
assessment a 2nd time).   

 Student score:  Select the score release option, it’s recommended that you 
choose the first option ‘Release the score once the assessment has been 
submitted’. 

 Statistics release:  Checkmark the release box if you want students to see how 
they performed in comparison to the rest of the class. 

 

 
 
 Dates Available:  Expand the Dates Available menu to select the start and end 

date for the Assessment, if you checkmark the box to add the Assessment to the 
calendar, the start date (not the due date) appears on the calendar. Note: The 
quiz will be listed under Assessments but the link to the quiz will not be active 
until the date and time you selected arrives.  
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 Results Settings:  Expand the Results Settings menu to select what results the 

student sees after submitting an assessment. 
 

 
 

 Expand the Submission Settings and Security Settings if needed.  The Submission 
Settings and Security Settings are not used very often, but the Security Settings 
can be used to add a password for a proctored lab exam. 

 Select Save to save the Settings. 
 

 
 
Making a Quiz Invisible to Students 
 

• If you wish the quiz to not be visible at all to students until a certain date, 
complete these steps: 

• Move to the Teach tab. 
• Click on the Assessments Tool within the Course Tools menu. 
• Use the Action Link attached to the name of the quiz and select Set 

Release Criteria.  

 
 
 
 

• Click on the Date Criteria button.    
 
 

• Input the appropriate dates for when you want the link to be visible to 
students. Make sure the Dates Available you set previously are within the Set 
Release Criteria dates you chose. Otherwise, the quiz will not be released to 
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students on the desired dates. If the Dates Available and the Set Release 
Criteria setting are in conflict, the Set Release Criteria will prevail. 

 
•   Click Save.  

 
Advanced Formatting options in Respondus 
 
Add a picture to a question or answer in Respondus 

 Click inside the question wording box or inside one of the answer boxes (where the 
picture will be located) 

 Click on the Camera icon  
 Browse to the picture on your computer or disk and select it, click OPEN 
 Type in the text description of the image, click OK 
 Something like <PIC_1> or <PIC_2> should appear in your question /answer box 
 Preview the picture by clicking on the Preview button 

 
Add sound/video to a question or answer in Respondus 

 Click inside the question wording box or inside one of the answer boxes 

 Click on the Camera icon  
 Browse to the sound on your computer or disk and select it, click OPEN 
 Select to add the sound as a linked object, type in the text link description that will 

appear in the question/answer 
 Something like <AV_1> or <AV_2> should appear in your question /answer box 
 Preview the sound by clicking on the Preview button, then click on the text link 

 
Add a webpage link to a question or answer in Respondus 

 Click inside the question wording box or inside one of the answer boxes  

 Click on the web link icon  
 In the bottom section of the box type in the Address URL, then type in the text link 

description (Text to be Displayed) 
 Something like <H_1> or <H_2> should appear in your question /answer box 
 Preview the link by clicking on the Preview button, then click on the link 

 
Change the Default Font for your quiz 

 Select the File menu, Select Preferences, click on the Edit & Publish tab 
 Select the option “Use font below in place of CMS font when publishing”, choose a 

font and size, click OK 
 
Use the HTML editor to type or copy and paste HTML code into your quiz 

 Click inside the question wording box or inside one of the answer boxes  

 Click on the HTML editor icon    
 Type in or copy and paste HTML code from another document into your question 
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Use the PowerEdit option in Respondus 
 Click inside the question wording box or inside one of the answer boxes  

 Click on the Power Edit button  
 Change the font for the specific question / answer, add a list, or add a table 
 Select the File menu, then Save & Exit to save the changes 

 
Import questions from a text file into Respondus 
 
If you use Multiple Choice and True/False questions in your quizzes and do not use images, 
it may be more efficient to type up your questions in Microsoft Word and import them into 
Respondus.  Also, most test bank software has an export option so that you could export all 
the questions from a test bank and use Respondus instead. 
 

 Open Microsoft Word and create a new Document.  Save it as an RTF file by 
selecting the File menu, Select Save As, Choose the location, Change the Save-As 
type to RTF and click on SAVE.  Respondus also imports text files so you can also 
choose to save it as TXT. 

 

 
 

 Type in your Multiple Choice & True/False Questions in the EXACT format specified by 
Respondus.  Do not format your questions/answers with colors or fonts as formatting 
will not transfer over. 

 
Example: 
1.  What is your name? 

*a.  Melanie 
b.  George 
c.  Anne 

 
- Type in the Question number with a period (or right parentheses), then a 

space, then the question, include the question mark at the end of the 
question. 

- Type in the answers (or True/False) by typing in a letter followed by a period 
(or right parentheses), then a space, then the answer 

- Put an asterisk directly before the letter of the correct answer 
 
Do NOT type a title at the top of the page or any have other information in your document 
other than the questions and answers. 

 Open Respondus and select Import 

Questions  
 

1. Select Rich Text in “Standard 
Format”  for the Type of file 
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2. Click on the Browse button to select the RTF file that contains your quiz 
3. Select the button next to Create a new document, named: and give the quiz a 

name, Select Exam if it will be a graded exam, Select Survey if it is an 
anonymous survey 

4. Checkmark Use “stem” plus question number… and type in a “stem” for the 
question name.  This question name is only used within Respondus but can make 
editing your quizzes simpler if needed, it is the Question Title.  (ex. quiz1_, 
chapter1_, colonial_, etc). 

5. Click on the PREVIEW button to see whether the import will be successful or not 
6. Fix any problems and repeat this process until there are no errors 
7. Click on FINISH to import the questions 

 
 Edit and/or publish the quiz, or use it as a test bank file by creating quizzes from it 

 
You can import images and import other question types to Respondus but it requires a little 
more work.  View the Respondus help documentation for the correct format. 
 
 
Create a quiz using existing Respondus “test banks” / quizzes 
 
Respondus can store Test Banks of questions from a publisher and can be used as a Test 
Bank to store questions, store each chapter’s questions or each subject’s question in a 
different Respondus file.  Then create your quizzes using these “Test Bank” files. 
 

 Create a new Respondus Quiz / Exam 
 Select the top Edit tab 
 Select the button at the left labeled “Copy from Another File” 
 Choose the Chapter / Test Bank / etc. that you want to copy questions from, click 

Open 
 

 
 

 View a question by clicking on the title of it, select a question by checkmarking the 
box to the left 

 When you have selected one or more questions, click on Add to End of List to 
insert them into the exam 
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Create Random Question Sets with Respondus 
 
A Question Set is a group of questions (a question pool) that quizzes can be randomly 
generated from.  You can create Question Set(s) within the Respondus software and 
transfer them to WebCT. 
 
Example: If you created a Question Set /Pool of 100 questions for Chapter 1 of your 
textbook, you could specify that a 15 question quiz is generated for each student.  WebCT 
will randomly select 15 questions out of your 100 question pool. 
 

 Create a Respondus Quiz containing all of the questions that will be possibly selected 
on the quiz, to create multiple question sets, you must group your questions 
together; they cannot be out of order.  (ex. You can create a set out of 1-5, 6-10 but 
cannot create a question set out of non-sequential questions 1, 5, 9, 10) 

To randomly display the multiple choice answers, select the checkbox when 

you create the question that is labeled    
 

 Under the Settings Tab, select “Question Sets”, click on “Question Sets” 
 Select the “Add New Set” radio button You can add multiple question sets to a quiz 
 Type in the FIRST number of the question in the set, and the LAST number in the set 
 Select the number of questions that you would like to randomly be chosen from the 

set, if you select all questions, they will be randomly sorted and numbered for each 
student 

 Type in the Point Value for the set.  When using questions sets, all the questions in a 
set must have the same point value 

 Click on the “Add New Set” button, Click OK. 
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 Repeat this process for each question set.  
 When you publish the quiz to WebCT, remember to checkmark the box that is 

labeled “Apply Question Sets”. 


